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Question Number : 1 Question Id : 2549896497 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following displays programs that are currently running in Windows 10 OS?
Options :
1.  Menu bar
2.  Task bar
3.  Title bar
4.  Status bar

   
Question Number : 1 Question Id : 2549896497 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्नलिखित में से कौन सा प्रोग्राम उन प्रोग्रामों को प्रदर्शित करता है जो वर्तमान में विंडोज़ 10 ओएस में चल रहे हैं?
Options :
1.  मेनू बार
2.  टास्क बार
3.  टाइटल बार
4.  स्टेटस बार

   
Question Number : 2 Question Id : 2549896883 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is NOT a unit of memory in the computers?
Options :
1.  Megabyte (MB)
2.  Gigabyte (GB)
3.  Nato byte (NB)
4.  Byte

   
Question Number : 2 Question Id : 2549896883 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्न में से कौन सी कं प्यूटर में प्रयुक्त मेमोरी की एक इकाई नहीं  है?
Options :
1.  मेगाबाइट (MB)

2.  गीगाबाइट (GB)

3.  नाटोबाइट (NB)

4.  बाइट
   
Question Number : 3 Question Id : 2549896885 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is NOT a type of RAM?
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Options :
1.  SRAM (Static RAM)
2.  Prime RAM
3.  DDR RAM (Double Data Rate RAM)
4.  SDRAM (Synchronous Dynamic RAM)

   
Question Number : 3 Question Id : 2549896885 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्न में से कौन सी एक प्रकार की RAM नहीं  है?
Options :
1.  SRAM (स्टेटिक रैम)

2.  प्राइम RAM

3.  DDR RAM (डबल डेटा रेट रैम)

4.  SDRAM (सिंक्रोनस डायनामिक रैम)
   
Question Number : 4 Question Id : 2549897535 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which keyboard shortcut is used to delete the text to the beginning of the word in an Open Office writer?
Options :
1.  Backspace
2.  Ctrl + Alt + Backspace
3.  Ctrl + Backspace
4.  Shift + Backspace

   
Question Number : 4 Question Id : 2549897535 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
ओपन ऑफिस राइटर (OpenOffice writer) में, किसी शब्द की शुरुआत से टेक्स्ट को डिलीट करने के  लिए निम्न में से किस की-बोर्ड शॉर्टकट का
उपयोग किया जाता है?
Options :
1.  Backspace
2.  Ctrl + Alt + Backspace
3.  Ctrl + Backspace
4.  Shift + Backspace

   
Question Number : 5 Question Id : 2549897580 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
______ is a volatile memory.
Options :
1.  RAM
2.  ROM
3.  EEPROM
4.  EPROM

   
Question Number : 5 Question Id : 2549897580 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
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Correct Marks : 1 Wrong Marks : 0
निम्न में से कौन सी एक उदवायी मेमोरी है?
Options :
1.  RAM
2.  ROM
3.  EEPROM
4.  EPROM

   
Question Number : 6 Question Id : 2549898470 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following functions converts text to number in a locale independent manner in Microsoft Excel 2019?
Options :
1.  LOCLEVALUE function
2.  TEXTVALUE function
3.  NUMTEXTVALUE function
4.  NUMBERVALUE function

   
Question Number : 6 Question Id : 2549898470 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Microsoft Excel 2019 में, कौन सा फं क्शन किसी स्थानीय स्वतंत्र तरीके  से टेक्स्ट को अक्षरों में बदलता है?
Options :
1.  LOCLEVALUE फं क्शन
2.  TEXTVALUE फं क्शन
3.  NUMTEXTVALUE फं क्शन
4.  NUMBERVALUE फं क्शन

   
Question Number : 7 Question Id : 2549898812 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
An input device that allows a user to input data into a computer system by speaking to it is known as ______.
Options :
1.  Microphone
2.  Mouse
3.  Projector
4.  Scanner

   
Question Number : 7 Question Id : 2549898812 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्न में से वह इनपुट डिवाइस कौन सी है जिसके  द्वारा बोलकर कं प्यूटर सिस्टम में डेटा इनपुट किया जा सकता है?
Options :
1.  माइक्रोफोन
2.  माउस
3.  प्रोजेक्टर
4.  स्कै नर
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Question Number : 8 Question Id : 2549899353 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following devices is used for translating information from the computer into pictorial form on a paper?
Options :
1.  Light pen
2.  Keyboard
3.  Plotter
4.  Touch panel

   
Question Number : 8 Question Id : 2549899353 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
किसी इनफार्मेशन को कं प्यूटर से पेपर पर चित्रात्मक रूप में परिवर्तित करने के  लिए निम्न में से किस डिवाइस का उपयोग किया जाता है ?
Options :
1.  लाइट पेन
2.  कीबोर्ड
3.  प्लॉटर
4.  टच पैनल

   
Question Number : 9 Question Id : 25498911744 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
CD is a(n) ______ type of data storage.
Options :
1.  optical
2.  electrical
3.  mechanical
4.  magnetic

   
Question Number : 9 Question Id : 25498911744 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
सीडी (CD), ___________ प्रकार का डेटा स्टोरेज है।
Options :
1.  ऑप्टिकल
2.  इलेक्ट्रिकल
3.  मैके निकल
4.  मैग्नेटिक

   
Question Number : 10 Question Id : 25498922521 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The full form of ISP is ________.
Options :
1.  Intranet Service Provider
2.  Internet System Provider
3.  Internet Service Provider
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4.  Internet Service Plan
   
Question Number : 10 Question Id : 25498922521 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
ISP का पूर्णरूप क्या है?
Options :
1.  Intranet Service Provider (इंट्रा नेट सर्विस प्रोवाइडर)
2.  Internet System provider (इंटरनेट सिस्टम प्रोवाइडर)
3.  Internet Service provider (इंटरनेट सर्विस प्रोवाइडर)
4.  Internet Service Plan (इंटरनेट सर्विस प्लान)

   
Question Number : 11 Question Id : 25498929851 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
A barcode scanner eccentrically consists of three different parts, EXCLUDING:
Options :
1.  The illumination system
2.  The virtual locking system
3.  The sensor
4.  The decoder

   
Question Number : 11 Question Id : 25498929851 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एक बारकोड स्कै नर में विलक्षण रूप से तीन अलग-अलग भाग होते हैं, सिवाय:
Options :
1.  इलुमिनेशन सिस्टम
2.  वर्चुअल लॉकिं ग सिस्टम
3.  सेंसर
4.  डिकोडर

   
Question Number : 12 Question Id : 25498930385 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In a Blue Ray Disc, Spacer-Layer thickness must be higher than ______ to avoid deterioration of the readout signal caused by the optical
crosstalk from adjacent layers.
Options :
1.  6 µm
2.  10 µm
3.  5 µm
4.  9 µm

   
Question Number : 12 Question Id : 25498930385 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
ब्लू रे  डिस्क में, आसन्न परतों से ऑप्टिकल क्रॉस टॉक के  कारण रीडआउट सिग्नल की गिरावट से बचने के  लिए स्पेसर-लेयर की मोटाई _______ से
अधिक होनी चाहिए।
Options :
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1.  6 µm
2.  10 µm
3.  5 µm
4.  9 µm

   
Question Number : 13 Question Id : 25498930889 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
________ refers to the learning with the use of technology that enables people to learn anytime or anywhere.
Options :
1.  E-learning
2.  Email
3.  E-commerce
4.  E-banking

   
Question Number : 13 Question Id : 25498930889 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
________ प्रौद्योगिकी के  उपयोग से सीखने को संदर्भित करता है जो लोगों को कभी भी या कहीं  भी सीखने में सक्षम बनाता है।
Options :
1.  इ-लर्निंग (E-Learning)

2.  इ-मेल (E-Mail)

3.  इ-कॉमर्स  (E-Commerce)

4.  इ-बैंकिं ग (E-Banking)
   
Question Number : 14 Question Id : 25498930980 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following molecules are usually composed in thermotropic liquid crystals?
Options :
1.  Oval molecules
2.  Circular molecules
3.  Rod like molecules
4.  Water molecules

   
Question Number : 14 Question Id : 25498930980 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्नलिखित में से कौन सा अणु आमतौर पर थर्मोट्रो पिक तरल क्रिस्टल में बना होता है?
Options :
1.  अंडाकार अणु (Oval molecules)

2.  वृत्ताकार अणु (Circular molecules)

3.  छड़ के  आकार के  अणु (Rod like molecules)

4.  जल अणु (Water molecules)
   
Question Number : 15 Question Id : 25498931003 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
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Which of the following is hexcode of command to 16 x 2 LCD instruction register to use '2 lines and 5 x 7 matrix'?
Options :
1.  0x38
2.  0x18
3.  0x14
4.  0x80

   
Question Number : 15 Question Id : 25498931003 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
'2 लाइन और 5 x 7 मैट्रिक्स' का उपयोग करने के  लिए 16 x 2 एलसीडी अनुदेश रजिस्टर के  कमांड का हेक्स कोड निम्नलिखित में से कौन सा है?
Options :
1.  0x38
2.  0x18
3.  0x14
4.  0x80

   
Question Number : 16 Question Id : 2549898920 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following protocols working on the Transport layer provides a connectionless service between hosts?
Options :
1.  IP
2.  ARP
3.  TCP
4.  UDP

   
Question Number : 16 Question Id : 2549898920 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
ट्रां सपोर्ट लेयर पर कार्यरत वह कौन सा प्रोटोकॉल है जो होस्ट के  बीच एक कनेक्शन रहित सेवा प्रदान करता है?
Options :
1.  IP
2.  ARP
3.  TCP
4.  UDP

   
Question Number : 17 Question Id : 2549899514 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What will you do when print head CANNOT travel its full horizontal distance?
Options :
1.  Install correct drivers
2.  Open the cover and make sure there is nothing obstructing the movement of the print head
3.  install ink cartridge
4.  Clear the clogged ink cartridge  

   
Question Number : 17 Question Id : 2549899514 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
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Correct Marks : 1 Wrong Marks : 0
यदि प्रिंट हेड अपनी पूर्ण क्षैतिज दू री तय नहीं  कर पा रहा है, तो आप क्या करेंगे?
Options :
1.  सही ड्रा इवर स्थापित करें .
2.  कवर खोलें और सुनिश्चित करें  कि प्रिंट हेड की गति में कोई बाधा नहीं  है
3.  इंक कार्ट्रि ज इनस्टॉल करें
4.  अवरुद्ध इंक कार्ट्रि ज को साफ करना

   
Question Number : 18 Question Id : 2549899526 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
If you try to print a high-quality photo and use plain paper setting, then the printout is:
Options :
1.  smeared/messy
2.  normal
3.  colourful
4.  high quality

   
Question Number : 18 Question Id : 2549899526 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
यदि आप उच्च-गुणवत्ता वाली फ़ोटो प्रिंट करने का प्रयास करते हैं लेकिन आपने प्लेन पेपर सेटिंग का उपयोग किया है, तो प्राप्त प्रिंटआउट कै सा होगा?
Options :
1.  अस्पष्ट / मैला
2.  सामान्य
3.  रंगीन
4.  उच्च गुणवत्ता वाला

   
Question Number : 19 Question Id : 25498910937 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following options of Windows 11 settings is used to connect a wireless printer?
Options :
1.  Bluetooth & devices 
2.  Network and internet
3.  Privacy & Security
4.  Personalization

   
Question Number : 19 Question Id : 25498910937 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
वायरलेस प्रिंटर को कनेक्ट करने के  लिए विंडोज 11 सेटिंग्स के  निम्नलिखित में से किस विकल्प का उपयोग किया जाता है?
Options :
1.  ब्लूटू थ एं ड डिवाइसेस
2.  नेटवर्क  एं ड इंटरनेट
3.  प्राइवेसी एं ड सिक्योरिटी
4.  पेर्सनालाइजेशन
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Question Number : 20 Question Id : 25498911140 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Saina has purchased an Apple phone. Which of the following operating systems is likely to be installed on her phone?
Options :
1.  Android
2.  Windows
3.  iOS
4.  Blackberry OS

   
Question Number : 20 Question Id : 25498911140 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
साइना ने एक एप्पल फोन खरीदा। उसके  फ़ोन में निम्नलिखित में से कौन सा ऑपरे टिंग सिस्टम इंस्टॉल होने की संभावना है?
Options :
1.  Android
2.  Windows
3.  iOS
4.  Blackberry OS

   
Question Number : 21 Question Id : 25498911278 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In Amplitude Modulation, generally, the modulation index is always ______ one.
Options :
1.  greater than or equal to
2.  greater than
3.  equal to
4.  less than

   
Question Number : 21 Question Id : 25498911278 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एम्पलीटू ड मॉडुलेशन में, सामान्य तौर पर मॉड्यूलेशन इंडेक्स हमेशा एक ______ होता है।
Options :
1.  से अधिक अथवा बराबर
2.  से अधिक
3.  के  बराबर
4.  से कम

   
Question Number : 22 Question Id : 25498913858 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following property of DES makes cipher very strong?
Options :
1.  Avalanche effect, completeness
2.  Avalanche effect, incompleteness
3.  Newton effect, completeness
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4.  Newton effect, incompleteness
   
Question Number : 22 Question Id : 25498913858 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
DES का निम्नलिखित में से कौन सा गुण सिफर को बहुत मजबूत बनाता है?
Options :
1.  अवालांचे प्रभाव, पूर्णता
2.  अवालांचे प्रभाव, अपूर्णता
3.  न्यूटन प्रभाव, पूर्णता
4.  न्यूटन प्रभाव, अपूर्णता

   
Question Number : 23 Question Id : 25498918552 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In which of the following OS intallation, the hard disk is formatted and completely erased?
Options :
1.  Clean Install
2.  In-Place Upgrade
3.  Repair Install
4.  Unrepair install

   
Question Number : 23 Question Id : 25498918552 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्नलिखित में से किस OS इंस्टॉलेशन में, हार्ड डिस्क को फ़ॉर्मेट किया जाता है और पूरी तरह से मिटा दिया जाता है?
Options :
1.  क्लीन इनस्टॉल
2.  इन-प्लेस अपग्रेड
3.  रिपेयर इनस्टॉल
4.  अनरिपेयर इनस्टॉल

   
Question Number : 24 Question Id : 25498920750 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is a device that connects two or more packet-switched networks or subnetworks?
Options :
1.  Router
2.  Firewalls
3.  Switches
4.  Repeater

   
Question Number : 24 Question Id : 25498920750 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्नलिखित में से कौन सा उपकरण है जो दो या दो से अधिक पैके ट-स्विच्ड नेटवर्क  या सबनेटवर्क  को जोड़ता है?
Options :
1.  राऊटर
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2.  फायरवॉल
3.  स्विच
4.  रिपीटर

   
Question Number : 25 Question Id : 25498924309 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is an example of sequential file access method?
Options :
1.  accessing randomly relative to the current position of the file pointer
2.   using index to access the file directly. 
3.  accessing one record right after another record in an order
4.  reading and writing record rapidly in no particular order

   
Question Number : 25 Question Id : 25498924309 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्न में से कौन सा एक सिक्वें शियल फाइल एक्सेस प्रणाली का उदाहरण है?
Options :
1.  फ़ाइल सूचक की वर्तमान स्थिति के  सापेक्ष यादृच्छिक रूप से पहुँचना
2.  फ़ाइल तक सीधे पहुंचने के  लिए इंडेक्स का उपयोग करना
3.  एक क्रम में एक रिकॉर्ड के  ठीक बाद दू सरे  रिकॉर्ड तक पहुँचना
4.  पढ़ना और लिखना बिना किसी विशेष क्रम के  तेजी से रिकॉर्ड होता है

   
Question Number : 26 Question Id : 25498924500 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
ISO is a file format of ______.
Options :
1.  disk files
2.  disc image files
3.  video files
4.  audio files

   
Question Number : 26 Question Id : 25498924500 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
ISO ____________ का फाइल फॉर्मेट है।
Options :
1.  डिस्क फाइल
2.  डिस्क इमेज फाइल
3.  वीडियो फाइल
4.  ऑडियो फाइल

   
Question Number : 27 Question Id : 25498924604 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
______ file has SWF file format.
Options :
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1.  Microsoft Encarta Document
2.  Adobe Flash Movie file
3.  Microsoft Office Document
4.  Image File

   
Question Number : 27 Question Id : 25498924604 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्न में से किस फाइल का फॉर्मेट SWF होता है?
Options :
1.  माइक्रोसॉफ्ट एनकार्टा डॉक्यूमेंट
2.  एडोब फ़्लैश मूवी फाइल
3.  माइक्रोसॉफ्ट ऑफिस डॉक्यूमेंट
4.  इमेज फाइल

   
Question Number : 28 Question Id : 25498925172 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The gzip method implements a public domain variation of:
Options :
1.  run length codes
2.  Huffman codes
3.  Lempel-Ziv algorithm
4.  dynamic Huffman codes

   
Question Number : 28 Question Id : 25498925172 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
gzip विधि में निम्न में से कौन सी सार्वजनिक डोमेन विविधता लागू होती है?
Options :
1.  रन लेंथ कोड्स
2.  हफमैन कोड्स
3.  लेमपेल-जिव एल्गोरिदम
4.  डायनामिक हफमैन कोड्स

   
Question Number : 29 Question Id : 25498938508 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
_______ operating system runs on a set of computers that are interconnected by a network.
Options :
1.  Stand alone
2.  Distributed
3.  Off-line
4.  Batch processing

   
Question Number : 29 Question Id : 25498938508 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
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_________ ऑपरे टिंग सिस्टम, कं प्यूटर के  उस सेट पर चलता है जो एक नेटवर्क  द्वारा आपस में जुड़े हुए होते हैं।
Options :
1.  स्टैंड अलोन
2.  डिस्ट्रिब्यूटेड
3.  ऑफलाइन
4.  बैच प्रोसेसिंग

   
Question Number : 30 Question Id : 25498940417 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In Microsoft Excel, a formula should always be preceded by a/an ______ sign.
Options :
1.  $
2.  =
3.  *
4.  #

   
Question Number : 30 Question Id : 25498940417 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Microsoft Excel में, किसी फॉर्मूले के  पहले हमेशा _________ चिह्न होना चाहिए।
Options :
1.  $
2.  =
3.  *
4.  #

   
Question Number : 31 Question Id : 2549896764 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What is World Wide Web?
Options :
1.  It is a series of webpages that are typically accessed through a web browser and are hosted on a web server
2.  It refers to the Web browser in the user's machine or mobile device.
3.  A collection of websites or webpages stored in web servers and connected to local computers through the internet
4.  It is a software application used to retrieve data from webpages

   
Question Number : 31 Question Id : 2549896764 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
वर्ल्ड वाइड वेब क्या है?
Options :
1.  यह वेबपेजों की एक श्रृंखला है जो आम तौर पर एक वेब ब्राउज़र के  माध्यम से एक्सेस की जाती है और एक वेब सर्वर पर होस्ट की जाती है
2.  यह उपयोगकर्ता की मशीन या मोबाइल डिवाइस में वेब ब्राउज़र को संदर्भित करता है
3.  वेब सर्वर में संग्रहीत और इंटरनेट के  माध्यम से स्थानीय कं प्यूटरों से जुड़ी वेबसाइटों या वेबपेजों का एक संग्रह
4.  यह एक सॉफ्टवेयर एप्लिके शन है जिसका उपयोग वेबपेजों से डेटा पुनर्प्राप्त करने के  लिए किया जाता है
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Question Number : 32 Question Id : 2549899066 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
______ transactions refer to situations where payment is done over the network and the amount gets transferred from one financial body
to another financial body without any involvement of a middleman.
Options :
1.  E-money
2.  E-bay
3.  E-biz
4.  E-plan

   
Question Number : 32 Question Id : 2549899066 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
_______ लेनदेन, उस स्थिति को संदर्भित करता है जिसमें भुगतान एक नेटवर्क  पर किया जाता है और राशि एक वित्तीय निकाय से किसी अन्य वित्तीय
निकाय पर किसी मध्यस्थ की भागीदारी के  बिना ही स्थानांतरित हो जाती है।
Options :
1.  ई-मनी
2.  ई-बे
3.  ई-बिज़
4.  ई-प्लान

   
Question Number : 33 Question Id : 2549899135 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The extensions .gov, .edu and .net are called:
Options :
1.  domain names
2.  mail to addresses
3.  email targets
4.  recipient's name

   
Question Number : 33 Question Id : 2549899135 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
.gov , .edu और .net एक्सटेंसन क्या कहलाते हैं?
Options :
1.  डोमेन के  नाम
2.  मेल के  लिए एड्रे स
3.  ई-मेल टार्गेट्स
4.  प्राप्तकर्ताओं के  नाम

   
Question Number : 34 Question Id : 25498911068 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What do you understand by font family in Windows?
Options :
1.  It is a characteristic of a font and its style.
2.  It is a set of fonts that have a common design

7/15/24, 6:18 PM Online Question Paper PDF Preview



3.  It is defined in points which are often equal to pixels on computer display.
4.  It is sets of numbers, punctuation and letters.

   
Question Number : 34 Question Id : 25498911068 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
विंडोज़ में फ़ॉन्ट परिवार से आप क्या समझते हैं?
Options :
1.  यह किसी फ़ॉन्ट और इसकी शैली की एक विशेषता है
2.  यह फ़ॉन्ट्स का एक सेट है जिसमें एक सामान्य डिज़ाइन होता है
3.  इसे उन बिंदुओं के  रूप में परिभाषित किया जाता है जो अक्सर कं प्यूटर डिस्प्ले के  पिक्सल के  बराबर होते हैं
4.  यह संख्याओं, विराम चिह्नों, अक्षरों का सेट है

   
Question Number : 35 Question Id : 25498911870 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is NOT a valid slide layout in MS-PowerPoint 2019?
Options :
1.  Title Slide
2.  Title and Content
3.  Section Header
4.  Paragraph Header

   
Question Number : 35 Question Id : 25498911870 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्नलिखित में से कौन MS-PowerPoint 2019 में एक वैलिड स्लाइड लेआउट नहीं  है?
Options :
1.  टाइटल स्लाइड
2.  टाइटल एं ड कं टेंट
3.  सेक्शन हैडर
4.  पैराग्राफ हैडर

   
Question Number : 36 Question Id : 25498911903 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
____________is the number system that we use on a daily basis based on the 10 digits. 
Options :
1.  binary
2.  decimal
3.  octal
4.  hexadecimal

   
Question Number : 36 Question Id : 25498911903 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
________ वह संख्या प्रणाली है जिसका उपयोग हम 10 अंकों के  आधार पर दै निक आधार पर करते हैं।
Options :
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1.  द्विधारी
2.  दशमलव
3.  अष्टाधारी
4.  षोडश आधारी

   
Question Number : 37 Question Id : 25498911947 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The binary equivalent of the decimal number '31' is ________.
Options :
1.  11111
2.  11011
3.  11110
4.  10111

   
Question Number : 37 Question Id : 25498911947 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
दशमलव संख्या '31' का बाइनरी समतुल्य क्या होगा?
Options :
1.  11111
2.  11011
3.  11110
4.  10111

   
Question Number : 38 Question Id : 25498924647 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which keyboard shortcut will you use to convert your text to BOLD in MS-Word 2019?
Options :
1.  ALT + B
2.  Ctrl + Shift + B
3.  Shift + F3
4.  Ctrl + B

   
Question Number : 38 Question Id : 25498924647 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Word 2019 में अपने टेक्स्ट को BOLD में बदलने के  लिए आप किस कीबोर्ड शॉर्टकट का उपयोग करेंगे?
Options :
1.  ALT + B
2.  Ctrl + Shift + B
3.  Shift + F3
4.  Ctrl + B

   
Question Number : 39 Question Id : 25498924662 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The base of the Hexa Decimal  number system is ______.
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Options :
1.  16
2.  11
3.  12
4.  13

   
Question Number : 39 Question Id : 25498924662 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
​हेक्सा दशमलव संख्या पद्धति की आधार संख्या क्या है?
Options :
1.  16
2.  11
3.  12
4.  13

   
Question Number : 40 Question Id : 25498924671 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In the given number (8)10, 10 is the _______ of the number system.
Options :
1.  base
2.  power
3.  exponent
4.  cube

   
Question Number : 40 Question Id : 25498924671 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
दी गई संख्या (8)10 में, 10 संख्या प्रणाली का _______ है।
Options :
1.  Base (आधारिक)

2.  Power (घातांकीय)

3.  Exponent (चर घातांकीय)

4.  Cube (घन)
   
Question Number : 41 Question Id : 25498925213 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following represents the binary number system?
Options :
1.  (11)10

2.  (11)2

3.  (11)8

4.  (11)16
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Question Number : 41 Question Id : 25498925213 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्न में से कौन सी संख्या बाइनरी संख्या प्रणाली से संबंधित है?
Options :
1.  (11)10

2.  (11)2

3.  (11)8

4.  (11)16

   
Question Number : 42 Question Id : 25498925279 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
WAN stands for:
Options :
1.  Web Area Network
2.  World Area Network
3.  Wide Area Network
4.  Worst Area Network

   
Question Number : 42 Question Id : 25498925279 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
WAN का पूर्णरूप क्या है?
Options :
1.  Web Area Network (वेब एरिया नेटवर्क )
2.  World Area Network (वर्ल्ड एरिया नेटवर्क )
3.  Wide Area Network (वाइड एरिया नेटवर्क )
4.  Worst Area Network (वर्स्ट एरिया नेटवर्क )

   
Question Number : 43 Question Id : 25498938396 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The purpose of _______________ is to transform a URL into a normalized or canonical URL so it is possible to determine if two
syntactically different URLs are equivalent.
Options :
1.  URL normalization 
2.  URL support
3.  URL balancing
4.  URL modification

   
Question Number : 43 Question Id : 25498938396 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
_______________ का उद्देश्य एक यूआरएल को सामान्यीकृ त या कै नोनिकल यूआरएल में बदलना है ताकि यह निर्धारित करना संभव हो कि दो
वाक्यात्मक रूप से भिन्न यूआरएल समकक्ष हैं या नहीं ।
Options :
1.  URL सामान्यीकरण
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2.  URL समर्थन
3.  URL संतुलन
4.  URL संशोधन

   
Question Number : 44 Question Id : 25498941576 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The binary equivalent of the decimal number 3 is ______.
Options :
1.  101
2.  110
3.  111
4.  011

   
Question Number : 44 Question Id : 25498941576 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
दशमलव संख्या 3 का बाइनरी समतुल्य क्या होगा?
Options :
1.  101
2.  110
3.  111
4.  011

   
Question Number : 45 Question Id : 25498941580 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The octal equivalent of the binary number 1001 is _______.
Options :
1.  15
2.  11
3.  10
4.  8

   
Question Number : 45 Question Id : 25498941580 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
बाइनरी संख्या 1001 का अष्टाधारी समतुल्य (octal equivalent) क्या होगा?
Options :
1.  15
2.  11
3.  10
4.  8

   
Question Number : 46 Question Id : 25498941594 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is the hardware in a computing device where the operating system, application programs and data in current use
are kept so they can be quickly reached by the device's processor?

7/15/24, 6:18 PM Online Question Paper PDF Preview



Options :
1.  RAM
2.  CD-ROM
3.  Flash Drive
4.  Hard Disk

   
Question Number : 46 Question Id : 25498941594 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्नलिखित में से कौन सा एक कं प्यूटिंग डिवाइस का हार्डवेयर है जहां ऑपरे टिंग सिस्टम, एप्लिके शन प्रोग्राम और वर्तमान उपयोग में आने वाले डेटा
को रखा जाता है ताकि उन तक डिवाइस के  प्रोसेसर द्वारा जल्दी से पहुंचा जा सके ?
Options :
1.  RAM
2.  CD-ROM

3.  फ्लैश ड्रा इव
4.  हार्ड डिस्क

   
Question Number : 47 Question Id : 25498941600 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The decimal equivalent of the binary number '11011' is __________.
Options :
1.  23
2.  25
3.  27
4.  29

   
Question Number : 47 Question Id : 25498941600 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
बाइनरी संख्या '11011' का दशमलव समतुल्य क्या होगा?
Options :
1.  23
2.  25
3.  27
4.  29

   
Question Number : 48 Question Id : 25498941619 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
________ is the shortcut key to apply a filter in MS-Excel 2019.
Options :
1.  Ctrl + Shift + L
2.  Ctrl + Shift + C
3.  Ctrl + Shift + K
4.  Ctrl + Shift + M

   
Question Number : 48 Question Id : 25498941619 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
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Correct Marks : 1 Wrong Marks : 0
Microsoft Excel 2019 में, फ़िल्टर लगाने के  लिए किस की-बोर्ड शॉर्टकट का उपयोग किया जाता है।
Options :
1.  Ctrl + Shift + L
2.  Ctrl + Shift + C
3.  Ctrl + Shift + K
4.  Ctrl + Shift + M

   
Question Number : 49 Question Id : 25498941621 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In Microsoft Excel 2019, the Field List option should appear when you click anywhere in the _________ table.
Options :
1.  Data
2.  Reference
3.  Pivot
4.  Quick

   
Question Number : 49 Question Id : 25498941621 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Microsoft Excel 2019 में, जब आप _____ तालिका में कहीं  भी क्लिक करते हैं तो फ़ील्ड सूची विकल्प दिखाई देना चाहिए।
Options :
1.  डेटा
2.  रेफरेंस
3.  पिवोट
4.  क्विक

   
Question Number : 50 Question Id : 25498941625 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is an example of email address?
Options :
1.  http://vianet.com/index.htm
2.  D:\ \Email\Standard
3.  joesmart@billme.com
4.  Chaminade.org/teachers/mail addresses

   
Question Number : 50 Question Id : 25498941625 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्न में से कौन ईमेल एड्रे स का उदाहरण है?
Options :
1.  http://vianet.com/index.htm
2.  D:\ \Email\Standard
3.  joesmart@billme.com
4.  Chaminade.org/teachers/mail addresses
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Question Number : 51 Question Id : 25498941641 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Identify the correct sequence of steps required to remove duplicate values in Microsoft Excel 2019.
Options :
1.  Go to the Data tab -> in data Tools group -> Click on Remove Duplicates
2.  Go to the Insert tab -> Click on Conditional Formatting -> Under Highlight Cells Rules click on Duplicate Values
3.  Go to the Design tab -> Click on Conditional Formatting -> Under Highlight Cells Rules click on Duplicate Values
4.  Go to the File tab -> Click on Conditional Formatting -> Under Highlight Cells Rules click on Duplicate Values

   
Question Number : 51 Question Id : 25498941641 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Microsoft Excel 2019 में, डु प्लिके ट मानों को हटाने के  लिए आवश्यक चरणों के  सही क्रम की पहचान कीजिए।
Options :
1.  डेटा टैब पर जाएं  -> डेटा टूल्स ग्रुप में -> रिमूव डु प्लिके ट्स पर क्लिक करें
2.  इन्सर्ट टैब पर जाएं  -> कं डीशनल फॉर्मेटिंग पर क्लिक करें  -> हाइलाइट सेल्स रूल्स के  अंतर्गत डु प्लिके ट वैल्यूज़ पर क्लिक करें
3.  डिज़ाइन टैब पर जाएं  -> कं डीशनल फॉर्मेटिंग पर क्लिक करें  -> हाइलाइट सेल्स रूल्स के  अंतर्गत डु प्लिके ट वैल्यूज़ पर क्लिक करें
4.  फाइल टैब पर जाएं  -> कं डीशनल फॉर्मेटिंग पर क्लिक करें  -> हाइलाइट सेल्स रूल्स के  अंतर्गत डु प्लिके ट वैल्यूज़ पर क्लिक करें

   
Question Number : 52 Question Id : 25498941645 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In Microsoft Excel 2019, the pivot table error ‘field name is not valid’ usually appears because ________.
Options :
1.  one or more row heading cells in the source data are blank
2.  one or more of the column heading cells in the source data is blank

3.  one or more column cells in the source data are blank
4.  the worksheet with the pivot table is full

   
Question Number : 52 Question Id : 25498941645 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Microsoft Excel 2019 में, पिवोट टेबल एरर ‘field name is not valid’ सामान्यतः  किस कारण आती है?
Options :
1.  स्रोत (Source) डेटा में एक या अधिक पंक्ति  (Row) शीर्षक कक्ष  (Heading Cell) रिक्त हैं।
2.  स्रोत (Source) डेटा में एक या अधिक स्तंभ शीर्षक कक्ष (Column Heading Cell) रिक्त हैं।
3.  स्रोत (Source) डेटा में एक या अधिक स्तंभ कक्ष (Column Cell) रिक्त हैं।
4.  पिवट टेबल वाली वर्क शीट भरी हुई है।

   
   

READING COMPREHENSION
Section Id : 2549897882
Section Number : 2
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 1
Number of Questions to be attempted : 1
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Section Marks : 5
Display Number Panel : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549897923
Question Shuffling Allowed : No
   
Question Id : 25498921283 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension
Questions : No Question Pattern Type : NonMatrix
Question Numbers : (53 to 57)
Read the given passage and answer the questions.

A young German workman came to Amsterdam. He went around the city and was deeply impressed by its beautiful buildings, ships and
busy people. He saw a large house more beautiful than any he had ever seen. For a long time he gazed at it in astonishment, its six
chimneys and its tall windows looked awesome. Finally, he asked a passer-by, “Could you please tell me the name of the gentleman who
owns this beautiful house?” But the man, who had more important matters to attend to, and who did not understand German, replied
‘Kannitverstan’ and went away. (This is a Dutch word which means “I cannot understand you.”) ``He must have been an awfully rich
man, this Mr. Kannitverstan,” our hero thought.

Walking through the streets of the town he came to the harbor. There were many ships there. His attention was caught by a large ship
which was being unloaded. Barrels full of sugar, coffee, rice and pepper were being rolled out. When he had watched for a long time, he
asked a man for the name of the man for whom the ship had brought all these goods. “Kannitverstan” was the reply. At this he thought,
“Aha, so that's how he can afford such a wonderful and amazing house.”

So he went away sorrowfully thinking how poor a man he was among so many rich people in this world. Just then, he turned a corner and
saw a long funeral procession. Four horses were pulling a black coffin box. A large number of people followed silently. Our hero stood
there in respect with his hat in his hands until they had all passed by. Then, he went up to the last man in the procession and said, “That
must have been a good friend of yours,” he said, “Who was he?” “Kannitverstan!?” came the reply.

He felt sad and relieved at once. “Poor Kannitverstan,” he exclaimed to himself, “What do you get from all your wealth now? I will get
the same from my poverty: a shroud and a sheet!” With these thoughts in mind, he accompanied the procession to the grave. He saw the
supposed Mr. Kannitverstan being lowered to his final resting place.
Sub questions
 
Question Number : 53 Question Id : 25498921284 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Who was Kannitverstan?
Options :
1.  A rich merchant
2.  A Dutchman
3.  The man who died
4.  Nobody
 
Question Number : 54 Question Id : 25498921285 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Whom does the term ‘our hero’ used in the passage refer to?
Options :
1.  Kannitverstan
2.  The passer-by
3.  The German traveler
4.  The man who died
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Question Number : 55 Question Id : 25498921286 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
When the traveler understood that the goods from the ship belonged to Kannitverstan, he was:
Options :
1.  sad at his own poverty
2.  amazed at the goods
3.  astonished to see the ship
4.  happy with the man’s riches
 
Question Number : 56 Question Id : 25498921287 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
When he discovered that Kannitverstan had died, the man was sad because:
Options :
1.  a very rich man had died
2.  a large crowd walked silently
3.  his wealth was of no use to him now
4.  his body was in a black coffin box
 
Question Number : 57 Question Id : 25498921288 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following options does NOT complete the given statement correctly?

After seeing the coffin, the traveler felt relieved because he understood that:
Options :
1.  there is no use of wealth after death
2.  in death a poor man also gets only a sheet
3.  death does not distinguish between the rich and the poor
4.  only the rich go to heaven

   
Question Id : 25498921283 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension
Questions : No Question Pattern Type : NonMatrix
Question Numbers : (53 to 57)
दिए गए गद्यांश को पढ़ें  और उसके  आधार पर प्रश्नों के  उत्तर दें।

एक युवा जर्मन कारीगर एम्स्टर्डम आया। वह पूरे  शहर में घूमा और यहां की खूबसूरत इमारतों, जहाजों और व्यस्त लोगों से काफी प्रभावित हुआ। उसने
एक बड़े से सुंदर घर को देखा, इतना सुंदर घर उसने पहले कभी नहीं  देखा था। वह उसे बड़ी देर तक एकटक देखता रहा। इसकी छः  चिमनियां और
लंबी-लंबी खिड़कियां शानदार लग रही थीं । अंत में उसने वहां से गुजर रहे एक व्यक्ति से पूछा, "क्या आप मुझे इस खूबसूरत घर के  मालिक का नाम
बता सकते हैं?" लेकिन वह आदमी किसी और काम की वजह से जल्दबाज़ी में था और उसे जर्मन भी ठीक से समझ में नहीं  आती थी, "कन्निटवेर्स्टन"
बोलकर आगे बढ़ गया। (यह एक डच शब्द है जिसका अर्थ है "आपकी बात मुझे समझ नहीं  आई।") हमारे  नायक ने सोचा, "श्री कन्निटवेर्स्टन अवश्य ही
बहुत अमीर व्यक्ति होंगे।”

शहर की सड़कों पर घूमते हुए वह बंदरगाह तक पहुंच गया। वहां कई जहाज थे। उनका ध्यान एक बड़े जहाज पर की ओर गया जिसपर से सामान
उतारा जा रहा था। चीनी, कॉफी, चावल और काली मिर्च से भरे  बैरल उसमें से निकाले जा रहे थे। वह यह बहुत देर तक सबकु छ देखता रहा फिर उसने
वहां पर एक व्यक्ति से पूछा कि जहाज से लाया जा रहा यह सब सामान किसका है? जवाब फिर से "कन्निटवेर्स्टन" था। अब उसे समझ आया कि
"कन्निटवेर्स्टन इतने सुंदर घर का मालिक कै से बना।"

इसलिए वह यह सोचकर दुखी होकर चला गया कि इस दुनिया में इतने सारे  अमीर लोगों के  बीच वह कितना गरीब आदमी था। तभी, वह एक कोने में
मुड़ा और एक लंबी शवयात्रा देखी। चार घोड़े एक काले ताबूत को खीं च रहे थे। बड़ी संख्या में लोग चुपचाप उसके  पीछे -पीछे  जा रहे थे। हमारा नायक
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उसके  सम्मान में तब तक अपने हाथों में अपनी टोपी लेकर शांत खड़ा रहा जबतक सभी लोग वहां से निकल नहीं  गए। फिर, वह जुलूस में आखिरी
आदमी के  पास गया और बोला, "वह तुम्हारा कोई अच्छा दोस्त रहा होगा," उसने कहा, "वह कौन था?" "कन्निटवेर्स्टन!?" जवाब आया।

उसे राहत मिश्रित दुः  ख हुआ। "बेचारा कन्निटवेर्स्टन," उसने खुद से कहा, "अब तुम्हें अपनी सारी दौलत से क्या मिलेगा? मुझे अपनी गरीबी से भी वही
मिलेगा: एक कफ़न और एक चादर!" इन विचारों को मन में लेकर वह जुलूस के  साथ कब्र तक गया। उन्होंने कथित मिस्टर कन्निटवेर्स्टन को उनके
अंतिम विश्राम स्थल पर ले जाते हुए देखा।
Sub questions
 
Question Number : 53 Question Id : 25498921284 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
कन्निटवेर्स्टन कौन था?
Options :
1.  एक धनी व्यापारी
2.  एक डचमैन
3.  व्यक्ति जो मर गया था
4.  कोई भी नहीं
 
Question Number : 54 Question Id : 25498921285 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
गद्यांश में, "हमारा नायक" शब्द निम्न में से किसके  लिए प्रयुक्त हुआ है?
Options :
1.  के न्नीवेर्स्टन के  लिए
2.  राहगीर के  लिए
3.  जर्मन यात्री के  लिए
4.  मृत व्यक्ति के  लिए
 
Question Number : 55 Question Id : 25498921286 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
जब यात्री को पता चला कि जहाज से उतारा जा रहा सामान कन्निटवेर्स्टन का है, तो वह ____________ |
Options :
1.  अपनी गरीबी पर उदास हुआ
2.  सामान देखकर आश्चर्यचकित हुआ
3.  जहाज को देखने से आश्चर्यचकित हुआ
4.  आदमी के  धन से खुश हुआ
 
Question Number : 56 Question Id : 25498921287 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
जब उसे पता चला कि मृत व्यक्ति कन्निटवेर्स्टन है, तो वह दुखी क्यों हुआ?
Options :
1.  इसलिए कि एक अमीर व्यक्ति की मृत्यु हो गई है
2.  इसलिए कि बहुत सी भीड़ मृत व्यक्ति के  पीछे  पीछे  जा रही है
3.  इसलिए कि उसका धन अब उसके  कभी काम नहीं  आएगा
4.  इसलिए क्योंकि उसका मृत शरीर एक काले ताबूत में था
 
Question Number : 57 Question Id : 25498921288 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
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Correct Marks : 1 Wrong Marks : 0
निम्न में से कौन सा विकल्प नीचे दिए गए कथन को सही ढंग से पूर्ण नहीं  करेगा?
ताबूत देखने के  बाद यात्री को राहत महसूस हुई क्योंकि;
Options :
1.  मृत्यु के  बाद धन का कोई उपयोग नहीं  है
2.  मृत्यु के  बाद एक गरीब आदमी को भी के वल एक चादर ही मिलती है
3.  मृत्यु अमीरों और गरीबों के  बीच अंतर नहीं  करती है
4.  के वल अमीर ही स्वर्ग में जाते हैं

   
   

QUANTITATIVE APTITUDE
Section Id : 2549897883
Section Number : 3
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 6
Number of Questions to be attempted : 6
Section Marks : 6
Display Number Panel : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549897924
Question Shuffling Allowed : Yes
   
Question Number : 58 Question Id : 25498928864 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Find the sum of first 15 terms of the Arithmetic series 3, 7, 11, 15, …….
Options :
1.  412
2.  440
3.  465
4.  488

   
Question Number : 58 Question Id : 25498928864 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
अंकगणित श्रृंखला 3, 7, 11, 15, …… के  पहले 15 पदों का योग ज्ञात कीजिए।
Options :
1.  412
2.  440
3.  465
4.  488

   
Question Number : 59 Question Id : 25498928919 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
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Options :
1.  840
2.  910
3.  1320
4.  1120

   
Question Number : 59 Question Id : 25498928919 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  

4.  

   
Question Number : 60 Question Id : 25498928935 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What should come in place of the question mark (?) in the following?

? % of 800 = 293 - 22% of 750
Options :
1.  14
2.  18
3.  12
4.  16

   
Question Number : 60 Question Id : 25498928935 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्नलिखित में प्रश्न चिन्ह (?) के  स्थान पर क्या आना चाहिए?

800 का  ?% = 293 - 750 का 22%
Options :
1.  14
2.  18
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3.  12
4.  16

   
Question Number : 61 Question Id : 25498929112 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Aman is a cricketer and his average score in ten matches is 40. If his average score in the first five matches is 45, then what is his average
score in the last five matches?
Options :
1.  38
2.  37
3.  36
4.  35

   
Question Number : 61 Question Id : 25498929112 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
अमन एक क्रिके टर है और दस मैचों में उसका औसत स्कोर 40 है। यदि पहले पांच मैचों में उसका औसत स्कोर 45 है, तो अंतिम पांच मैचों में उसका
औसत स्कोर क्या है?
Options :
1.  38
2.  37
3.  36
4.  35

   
Question Number : 62 Question Id : 25498929428 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
If Sn is the sum of the first n terms of an arithmetic progression and S9 = 72, then the sum of its 2nd, 4th and 9th terms is:

Options :
1.  20
2.  24
3.  30
4.  36

   
Question Number : 62 Question Id : 25498929428 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  
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4.  

   
Question Number : 63 Question Id : 25498929446 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The entry fee to an exhibition was reduced by 25%, which increased the sale by 20%. The percentage increase in the number of visitors
was :
Options :
1.  40%
2.  55%
3.  60%
4.  80%

   
Question Number : 63 Question Id : 25498929446 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एक प्रदर्शनी में प्रवेश शुल्क 25% कम कर दिया गया, जिससे बिक्री 20% बढ़ गई। आगंतुकों (Visitors) की संख्या में कितने प्रतिशत की वृद्धि हुई?
Options :
1.  40%
2.  55%
3.  60%
4.  80%

   
   

GENERAL MENTAL ABILITY AND REASONING
Section Id : 2549897884
Section Number : 4
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 6
Number of Questions to be attempted : 6
Section Marks : 6
Display Number Panel : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549897925
Question Shuffling Allowed : Yes
   
Question Number : 64 Question Id : 25498910064 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following words will come second if all of them are arranged alphabetically as in a dictionary?
Options :
1.  Tennis
2.  Tendon
3.  Tender
4.  Tempest
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Question Number : 64 Question Id : 25498910064 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
विकल्पों में दिए गए शब्दों को यदि अंग्रेजी शब्दकोश के  अनुसार वर्णानुक्रम में व्यवस्थित किया जाए, तो निम्न में से कौन सा शब्द दू सरे  स्थान पर
आएगा?
Options :
1.  Tennis
2.  Tendon
3.  Tender
4.  Tempest

   
Question Number : 65 Question Id : 25498910152 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Select the option that is related to the third word in the same way as the second word is related to the first word.

Entrepreneur : Profit :: Scholar : ?
Options :
1.  Income
2.  Knowledge
3.  Service
4.  Business

   
Question Number : 65 Question Id : 25498910152 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
उस विकल्प का चयन करें  जो तीसरे  शब्द से उसी प्रकार संबंधित है जैसे दू सरा शब्द पहले शब्द से संबंधित है।

उद्यमी : लाभ :: विद्वान : ?
Options :
1.  आय
2.  ज्ञान
3.  सेवा
4.  व्यापार

   
Question Number : 66 Question Id : 25498919025 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Select the word from the options that is similar to the given set of words in a certain way.

Dozen, Score, Decade
Options :
1.  Century
2.  Number
3.  Measurement
4.  Counting

   
Question Number : 66 Question Id : 25498919025 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0

7/15/24, 6:18 PM Online Question Paper PDF Preview



विकल्पों में से उस शब्द का चयन करें  जो एक निश्चित तरीके  से दिए गए शब्दों के  समूह के  समान है।

दर्जन, स्कोर, दशक
Options :
1.  शताब्दी
2.  संख्या
3.  माप
4.  गिनती

   
Question Number : 67 Question Id : 25498919616 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Select the most appropriate description about the given set of words.

Kanha : Periyar : Dachigam
Options :
1.  These are famous lagoons.
2.  These are hill stations.
3.  These are animal sanctuaries.
4.  These are mountain peaks.

   
Question Number : 67 Question Id : 25498919616 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
दिए गए शब्दों के  समूह के  बारे  में सबसे उपयुक्त विवरण का चयन करें।

कान्हा: पेरियार: दाचीगाम
Options :
1.  ये सभी प्रसिद्ध झीलें हैं।
2.  ये सभी पहाड़ी स्थल हैं।
3.  ये सभी वन्यजीव अभ्यारण्य हैं
4.  ये सभी पर्वत चोटियां हैं।

   
Question Number : 68 Question Id : 25498939756 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
'THEREFORE' is related to 'TEEOERFRH' in the same way as 'HELICOPTER' is related to '___________'.
Options :
1.  HELICORETP
2.  HLCPERTOIE
3.  RETPOCILEH
4.  RETPOCILHE

   
Question Number : 68 Question Id : 25498939756 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
THEREFORE, TEEOERFRH से उसी प्रकार से संबंधित है, जिस प्रकार HELICOPTER, ________________से संबंधित है।
Options :
1.  HELICORETP
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2.  HLCPERTOIE
3.  RETPOCILEH
4.  RETPOCILHE

   
Question Number : 69 Question Id : 25498940047 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Select the word-pair in which the two words share a different relationship from that shared by the two words in the rest of the word-pairs.
Options :
1.  Avesta : Parsi
2.  Torah : Jew
3.  Tripitaka : Buddhist
4.  Temple : Hindu

   
Question Number : 69 Question Id : 25498940047 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
उस शब्द-युग्म का चयन करें  जिसमें दो शब्द शेष शब्द-जोड़ियों में दो शब्दों द्वारा साझा किए गए संबंध से भिन्न संबंध साझा करते हैं।
Options :
1.  अवेस्ता : पारसी
2.  तोराह : यहूदी
3.  त्रिपिटक : बौद्धधर्म
4.  मंदिर : हिंदू

   
   

GENERAL AWARENESS
Section Id : 2549897885
Section Number : 5
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 6
Number of Questions to be attempted : 6
Section Marks : 6
Display Number Panel : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549897926
Question Shuffling Allowed : Yes
   
Question Number : 70 Question Id : 2549895329 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Kudremukh hills, known for iron ore deposits, is situated in:
Options :
1.  Chikmagalur
2.  Mangalore
3.  Satara
4.  Belgaum
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Question Number : 70 Question Id : 2549895329 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
लौह अयस्क भंडार के  लिए प्रसिद्ध कु द्रेमुख पहाड़ियां कहाँ पर स्थित है?
Options :
1.  चिकमंगलूर
2.  मंगलौर
3.  सातारा
4.  बेलगाम

   
Question Number : 71 Question Id : 2549899665 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Gold mines in India are located mainly at:
Options :
1.  Kolar
2.  Raniganj
3.  Jadugoda
4.  Veeranam

   
Question Number : 71 Question Id : 2549899665 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
भारत में सोने की खान, मुख्यतः  ______ में स्थित हैं।
Options :
1.  कोलार
2.  रानीगंज
3.  जादुगोडा
4.  वीरानम

   
Question Number : 72 Question Id : 25498912801 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Who amongst the following is the highest wicket taker in the history of cricket as of October 2021? (Both ODI and Test Cricket)
Options :
1.  Wasim Akram
2.  Anil Kumble
3.  Stephen Fleming
4.  Muttiah Muralitharan

   
Question Number : 72 Question Id : 25498912801 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
अक्टूबर 2021 तक क्रिके ट के  इतिहास में निम्नलिखित में से कौन सबसे अधिक विके ट लेने वाला गेंदबाज है? (वनडे और टेस्ट क्रिके ट दोनों)
Options :
1.  वसीम अकरम
2.  अनिल कुं बले
3.  स्टीफन फ्लेमिंग
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4.  मुथैया मुरलीधरन
   
Question Number : 73 Question Id : 25498922846 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following has the scientific name Pheretima posthuma?
Options :
1.  Leech
2.  Nereis
3.  Earthworm
4.  Tapeworm

   
Question Number : 73 Question Id : 25498922846 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
फे रे टिमा पोस्टहुमा (Pheretima posthuma), निम्नलिखित में से किस विकल्प का वैज्ञानिक नाम है?
Options :
1.  लीच
2.  नेरिस
3.  कें चुआ
4.  फीता कृ मि

   
Question Number : 74 Question Id : 25498933645 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which amendment of the Constitution of India provides constitutional status to the Panchayati Raj institution?
Options :

1.  71st Amendment

2.  73rd Amendment

3.  77th Amendment

4.  79th Amendment
   
Question Number : 74 Question Id : 25498933645 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
भारत के  संविधान का कौन सा संशोधन पंचायती राज संस्था को संवैधानिक दर्जा प्रदान करता है?
Options :
1.  71 वां संशोधन
2.  73 वां संशोधन
3.  77 वां संशोधन
4.  79 वां संशोधन

   
Question Number : 75 Question Id : 25498935418 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The excess of price that a person is to pay rather than forego the consumption of a commodity is called ______________.
Options :
1.  price
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2.  profit
3.  producer’s surplus
4.  consumer’s surplus

   
Question Number : 75 Question Id : 25498935418 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
किसी वस्तु की खपत त्यागने के  बजाय व्यक्ति द्वारा भुगतान की जाने वाली अतिरिक्त कीमत निम्नलिखित में से क्या कहलाती है?
Options :
1.  कीमत
2.  लाभ
3.  उत्पादक अधिशेष
4.  उपभोक्ता अधिशेष

   
   

English Mock
Group Number : 2
Group Id : 2549894964
Group Maximum Duration : 5
Group Minimum Duration : 5
Show Attended Group? : No
Edit Attended Group? : No
Break time : 1
Mandatory Break time : Yes
Group Marks : 0
   
   

English Mock
Section Id : 2549897886
Section Number : 1
Section type : Typing Test
Mandatory or Optional : Mandatory
Number of Questions : 1
Number of Questions to be attempted : 1
Section Marks : 0
Display Number Panel : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549897927
Question Shuffling Allowed : No
Is Section Default? : Yes
   
Question Number : 76 Question Id : 25498941117 Question Type : TYPING TEST Display Question Number : Yes Calculator :
None
Summer camps are supervised camps conducted to entertain as well as equip students with various life skills such as teamwork,
socializing, decision making, independent and responsible living and more. It aids the overall development of a child and children
have fun during this process as they get to explore new arenas.
Restricted/ Unrestricted : Unrestricted
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Paragraph Display : Yes
Keyboard Layout : Inscript
Show Details Panel : Yes
Show Error Count : Yes
Highlight Correct or Incorrect Words : Yes
Allow Back Space : Yes
Show Back Space Count : Yes
   
   

English Actual
Group Number : 3
Group Id : 2549894965
Group Maximum Duration : 15
Group Minimum Duration : 15
Show Attended Group? : No
Edit Attended Group? : No
Break time : 3
Mandatory Break time : Yes
Group Marks : 0
   
   

English Typing Test
Section Id : 2549897887
Section Number : 1
Section type : Typing Test
Mandatory or Optional : Mandatory
Number of Questions : 1
Number of Questions to be attempted : 1
Section Marks : 0
Display Number Panel : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549897928
Question Shuffling Allowed : No
Is Section Default? : Yes
   
Question Number : 77 Question Id : 25498941466 Question Type : TYPING TEST Display Question Number : Yes Calculator :
None
There is a consensus of expert opinion that cricket may have been invented during Saxon or Norman times by children living in
the Weald. It is an area of dense woodlands and clearings in south England. The first reference to cricket being played as an adult
sport was in early sixteenth century. In the same year a dictionary defined cricket as a game. There is also the thought that
cricket may have derived from bowls. It was an intervention of a batsman trying to stop the ball from reaching its target by
hitting it away. Village cricket had developed by the middle of the seventeenth century. The first English county teams were
formed in the second half of the same century. The local experts from village cricket were employed as the earliest professionals.
The first known game in which the teams use county names was played in the first decade of the seventeenth century. In the first
half of the eighteenth century cricket established itself as a leading sport in London and its nearby counties. Its spread was
limited by the constraints of travel. Still it was slowly gaining popularity in all the other parts of England. The first laws of
cricket were written in the middle of the seventeenth century. In the last quarter of seventeenth century these laws were
amended. The two prime changes being the addition of the third stump and defining the maximum bat width. The codes were
drawn up by the Star and Garter Club. The members of this club ultimately founded the famous Marylebone Cricket Club.
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Marylebone Cricket Club immediately became the custodian of the laws and has made revisions ever since then to the current
day. Cricket was introduced to North America via the English colonies as early as the seventeenth century. In the eighteenth
century it arrived in other parts of the globe. It was introduced to the West Indies by colonists and to India by British East India
Company mariners. It arrived in Australia almost as soon as colonisation began and the sport reached New Zealand and South
Africa in the early years of the nineteenth century. The development of the railway network also helped the spread of cricket as
teams from a long distance apart could play one other without a time consuming journey. Now even the spectators could travel
longer distances to matches. This resulted in increasing the size of crowds. The overarm bowling was leaglised in the seventh
decade of eighteenth century. It also marked a notable first with the publication of the first Wisden Almanack. This continues to
this day. In the same year Grace began his long and influential career. He contributed greatly in increasing the popularity of the
cricket. The first every international cricket game was played between the United State and Canada. This game was played in the
middle of the eighteenth century. Six year after the first English team toured Australia a team of Australian aborigines toured
England. The first test matched were played at the start of the last quarter of the nineteenth century. The following year
Australians toured England for the first time and the success of this tour ensured a popular demand for similar ventures in
future. The Australian victory in a tense finish gave rise to The Ashes series.
Restricted/ Unrestricted : Unrestricted
Paragraph Display : Yes
Keyboard Layout : Inscript
Show Details Panel : Yes
Show Error Count : Yes
Highlight Correct or Incorrect Words : Yes
Allow Back Space : Yes
Show Back Space Count : Yes
   
   

Hindi Mock
Group Number : 4
Group Id : 2549894966
Group Maximum Duration : 10
Group Minimum Duration : 10
Show Attended Group? : No
Edit Attended Group? : No
Break time : 5
Mandatory Break time : Yes
Group Marks : 0
   
   

Hindi Mock
Section Id : 2549897888
Section Number : 1
Section type : Typing Test
Mandatory or Optional : Mandatory
Number of Questions : 1
Number of Questions to be attempted : 1
Section Marks : 0
Display Number Panel : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549897929
Question Shuffling Allowed : No
Is Section Default? : Yes
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Question Number : 78 Question Id : 25498944390 Question Type : TYPING TEST Display Question Number : Yes Calculator :
None
एक बार की बात है, अकबर और बीरबल शिकार पर जा रहे थे। अभी कु छ समय की उन्हें एक हिरण दिखा। जल्दबाजी में तीर निकालते हुए
अकबर अपने हाथ पर घाव लगा बैठा। अब हालात कु छ ऐसे थे की अकबर बहुत दर्द में था और गुस्से में भी।
Restricted/ Unrestricted : Unrestricted
Paragraph Display : Yes
Keyboard Layout : Remington
Show Details Panel : Yes
Show Error Count : Yes
Highlight Correct or Incorrect Words : Yes
Allow Back Space : Yes
Show Back Space Count : Yes
   
   

Hindi Actual
Group Number : 5
Group Id : 2549894967
Group Maximum Duration : 15
Group Minimum Duration : 15
Show Attended Group? : No
Edit Attended Group? : No
Break time : 0
Group Marks : 0
   
   

Hindi Typing Test
Section Id : 2549897889
Section Number : 1
Section type : Typing Test
Mandatory or Optional : Mandatory
Number of Questions : 1
Number of Questions to be attempted : 1
Section Marks : 0
Display Number Panel : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549897930
Question Shuffling Allowed : No
Is Section Default? : Yes
   
Question Number : 79 Question Id : 25498945133 Question Type : TYPING TEST Display Question Number : Yes Calculator :
None
सपने हमारे  आनेवाले कल को सही आकार देने में एक जरुरी भूमिका निभाते हैं। यह सच ही कहा गया है कि यदि आप कु छ सोच सकते हैं तो
आप उसे हासिल भी कर सकते हैं। इसलिए यदि आपके  पास सपना है तो इसे अपनी मंजिल के  रूप में कायम करें  और इसे हासिल करने के
लिए कडी मेहनत करें। हालांकि यह कहना बहुत आसान है बजाए करने के  लेकिन अगर आप सच में इसे हासिल करने के  लिए कडी मेहनत
करते हैं तो आप इसे जरुर हासिल करने में सक्षम हों गे। जिंदगी में आपका एक बडा सपना हो सकता है लेकिन इसे हासिल करने के  लिए
आपको छोटे और बडे दोनों  ही इरादे रखने हों गे। हमेशा एक समय में एक कदम उठाना ही आपकी मदद कर सकता है। उदाहरण के  लिए
मेरा सपना फै शन डिजाइनर बनना है और मैं जानता हूं कि यह तभी संभव होगा यदि मैं किसी नामी पीठ से फै शन डिजाइनिंग में कोर्स पूरा
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करूं । हालांकि फै शन की दुनिया के  बारे  में जानने के  लिए फै शन मैगजीन देखने से मुझे कोई नहीं  रोक सकता। ऐसे छोटे कदम उठाने से मैं
अपने सपनों  को पा सकता हूं। हालांकि मेरी अंतिम मंजिल एक फै शन डिजाइनर बनना है। मैंने आने वाले महीनों  और वर्ष के  लिए कई छोटी
चीजे निर्धारित की हैं ताकि ये मुझे अपनी अंतिम मंजिल तक ले जा सकें । सपनों  को हासिल करने में प्रमुख बाधाओं में एक प्रेरणा की कमी है।
बहुत से लोग अपने सपनों  को पूरा करना छोड देते हैं वे बीच में थक जाते हैं। सपने पूरे  करने के  लिए प्रेरित रहना जरूरी है और जब आप
अपना सपना पूरा कर लें तब ही रूकें । यदि कभी आप अपने आप को निराश और थका हुआ मानते हैं तो यह अपनी अंतिम मंजिल को याद
करने का समय है और असली आनंद तथा गौरव का अनुभव आपको तब होगा जब आप इसे हासिल करेंगे। आप एक चीज को भी हासिल
करने के  लिए इनाम रखें। खुद को एक पोशाक खरीदने या अपने पसंदीदा कै फे  पर जाकर या मित्रों  के  साथ बाहर जाने जैसा कु छ भी हो
सकता है। अपनी मंजिल को हासिल करने के  लिए प्रेरित रहने का यह एक सही तरीका है। बहुत अधिक काम और किसी प्रकार का खेल ना
खेलना आपके  निर्माण को कमजोर कर सकता है। इस प्रकार यह एक बेहतर विचार है कि आप अपने काम से कु छ समय निकाले और ऐसा
काम करे  जिसे करने में आपको आनंद आता है। आदर्श रूप से आप अपने पसंदीदा खेल में शामिल होने के  लिए हर दिन अपने कार्यक्रम से
आधा घंटा निकाल ले। उन लोगों  के  साथ रहें जो आपके  सपनों  में यकीन रखते हैं और आपको प्रेरित रहने के  लिए कडी मेहनत करने के  लिए
जोश भरते हैं। यह प्रेरित रहने के  लिए एक बढिया तरीका है। निराश होने और अपने सपनों  को छोडने के  बजाए जब आप गलती करते हैं
और कठिन समय का सामना करते हैं तो आपको अपनी गलतियों  से सीखने और खुद को मजबूत करने की कोशिश करनी चाहिए। जैसे
आप अपने सपने और मंजिल को निर्धारित करते हैं तो उसके  लिए एक योजना बनाना जरुरी है जो आपको सही दिशा में जाने के  लिए
सहायता करे। योजना तैयार करना और संगठित रहकर अपने सपने को हासिल करना प्रारं भिक कदम हैं। बडे सपने देखिए और हर बाधा
को दू र करने के  लिए कडी मेहनत करिए।
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